HP Deskjet 1510 series
# Table of contents

1 HP Deskjet 1510 series Help ........................................................................................................... 1

2 Get to know the HP Deskjet 1510 series .................................................................................. 3
   Printer parts .......................................................................................................................... 4
   Control panel features ........................................................................................................ 5
   Status light .......................................................................................................................... 6
   Auto-Off .............................................................................................................................. 9

3 Print ........................................................................................................................................... 11
   Print documents ................................................................................................................... 12
   Print photos ........................................................................................................................ 14
   Print envelopes .................................................................................................................. 15
   Print using the maximum dpi .............................................................................................. 16
   Tips for print success .......................................................................................................... 17

4 Paper basics ............................................................................................................................. 19
   Recommended papers for printing ..................................................................................... 20
   Load media .......................................................................................................................... 22

5 Copy and scan .......................................................................................................................... 27
   Copy documents .................................................................................................................. 28
   Scan to a computer .............................................................................................................. 30
   Tips for copy success .......................................................................................................... 32
   Tips for scan success .......................................................................................................... 33

6 Work with ink cartridges .......................................................................................................... 35
   Check estimated ink levels ................................................................................................. 36
   Order ink supplies ................................................................................................................ 37
   Choose right ink cartridges ................................................................................................. 38
   Replace ink cartridges ........................................................................................................ 39
   Use single-cartridge mode ................................................................................................. 41
Cartridge warranty information ........................................................................................................ 42
Tips for working with ink cartridges ................................................................................................. 43

7 Connectivity .................................................................................................................................. 45
   Connect a new printer .................................................................................................................... 46
   USB connection ............................................................................................................................ 47

8 Solve a problem ............................................................................................................................. 49
   Improve print quality ..................................................................................................................... 50
   Clear paper jam ............................................................................................................................ 54
   Unable to print .............................................................................................................................. 57
   Clear print carriage ....................................................................................................................... 60
   Identify a defective cartridge ......................................................................................................... 61
   Prepare trays ................................................................................................................................ 62
   Resolve copy and scan issues .......................................................................................................... 63
   Printer failure ............................................................................................................................... 64
   Ink cartridge problem .................................................................................................................... 65
   Older generation cartridges ............................................................................................................ 67
   HP support .................................................................................................................................... 68

Appendix A Technical information .................................................................................................... 71
   Hewlett-Packard Company notices ............................................................................................... 72
   Specifications ................................................................................................................................ 73
   Environmental product stewardship program ................................................................................. 76
   Regulatory notices ......................................................................................................................... 80

Index .................................................................................................................................................. 85
Learn how to use your HP Deskjet 1510 series

- Printer parts on page 4
- Control panel features on page 5
- Load media on page 22
- Copy documents on page 28
- Scan to a computer on page 30
- Replace ink cartridges on page 39
- Clear paper jam on page 54
2 Get to know the HP Deskjet 1510 series

- Printer parts
- Control panel features
- Status light
- Auto-Off
Printer parts

● Front view

1. Input tray
2. Input tray guard
3. Ink cartridges
4. Lid
5. Lid-backing
6. Paper-width guide for the input tray
7. Control panel
8. Cartridge access door
9. Output tray
10. Output tray extender (also referred to as the tray extender)
11. Scanner glass

● Rear view

12. USB port
13. Power connection
## Control panel features

### Figure 2-1 Control panel features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On button: Turns the printer on or off.</td>
</tr>
<tr>
<td>2</td>
<td>Cancel button: Stops the current operation.</td>
</tr>
<tr>
<td>3</td>
<td>Start Copy Black button: Starts a black-and-white copy job. Acts as a resume button after resolving print problems.</td>
</tr>
<tr>
<td>4</td>
<td>Start Copy Color button: Starts a color copy job. Acts as a resume button after resolving print problems.</td>
</tr>
<tr>
<td>5</td>
<td>Attention light: Indicates that there is a paper jam, the printer is out of paper, or some event that requires your attention.</td>
</tr>
<tr>
<td>6</td>
<td>Cartridge lights: Indicates low ink or an ink cartridge problem.</td>
</tr>
</tbody>
</table>
### Status light

- When the printer is turned on, the **On** button light is lit.
- When the printer is turned off, the **On** button light is off.
- When the printer is in Sleep mode, the **On** button light is dimmed. The printer automatically enters Sleep mode after 5 minutes of inactivity.
- When the printer is processing a job, the **On** button light is blinking.

Additional blinking lights signal errors that you can resolve. See below to learn about light behavior and what to do.

<table>
<thead>
<tr>
<th>Light behavior</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Attention</strong> light is blinking.</td>
<td>The output tray is closed when printing is attempted, there is no paper, there is a paper jam, or the scanner is not working.</td>
</tr>
<tr>
<td></td>
<td>- If the output tray is closed, open it.</td>
</tr>
<tr>
<td></td>
<td>- If there is no paper, load paper, and then press any button, except the <strong>Cancel</strong> button, to resume printing.</td>
</tr>
<tr>
<td></td>
<td>- If one of ink cartridges is missing, the printer enters the single-cartridge mode automatically. To exit the single-cartridge mode, insert the corresponding ink cartridge. For more information, see <a href="#">Use single-cartridge mode on page 41</a>.</td>
</tr>
<tr>
<td></td>
<td>- If there is a paper jam, clear the paper jam, and then press any button, except the <strong>Cancel</strong> button, to resume printing. For more information, see <a href="#">Clear paper jam on page 54</a>.</td>
</tr>
<tr>
<td></td>
<td>If the problem persists, contact HP. The printer can still print even if the scanner is not working.</td>
</tr>
<tr>
<td>Both <strong>Cartridge</strong> lights and the <strong>Attention</strong> light are blinking.</td>
<td>The cartridge access door is open, or the carriage inside the printer is stalled.</td>
</tr>
<tr>
<td></td>
<td>- If the cartridge access door is open, close it. See <a href="#">Prepare trays on page 62</a> for more information.</td>
</tr>
<tr>
<td></td>
<td>- If the carriage is stalled, open the cartridge access door, move the carriage to the right to clear the obstruction, and then close the cartridge access door. Press any button, except the <strong>Cancel</strong> button, to resume printing. See <a href="#">Clear print carriage on page 60</a> for more information.</td>
</tr>
<tr>
<td>Light behavior</td>
<td>Cause and Solution</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>One Cartridge light is on (not blinking).</td>
<td>An “on” Cartridge light indicates that the corresponding ink cartridge still has the tape on, is low on ink, is missing, or is counterfeit.</td>
</tr>
</tbody>
</table>
| ![Light](image) | - If the pink tape is still on the ink cartridge, remove it.  
- If the ink cartridge is low on ink, replace the ink cartridge when print quality is no longer acceptable. For more information, see Replace ink cartridges on page 39.  
- If one of ink cartridges is missing, the printer enters to the single-cartridge mode automatically. To exit the single-cartridge mode, insert the corresponding ink cartridge. For more information, see Use single-cartridge mode on page 41.  
- If the ink cartridge is counterfeit, replace the corresponding ink cartridge with an original HP ink cartridge, or press any button, except the Cancel button, to resume printing. |
| Both Cartridge lights are on (not blinking). | Both ink cartridges are low on ink. |
| ![Lights](image) | - Replace both ink cartridges when print quality is no longer acceptable. For more information, see Replace ink cartridges on page 39. |
| One Cartridge light is blinking. | A “blinking” Cartridge light indicates that the corresponding ink cartridge is not installed correctly, is incompatible, or is very low on ink. |
| ![Light](image) | - If the ink cartridge is not installed correctly, reinsert the ink cartridge.  
- If the ink cartridge is incompatible, replace it with a compatible ink cartridge.  
- If the ink cartridge is very low on ink, press any button, except the Cancel button, to resume printing, and replace the corresponding ink cartridge when print quality is no longer acceptable. |
<table>
<thead>
<tr>
<th>Light behavior</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both Cartridge lights are blinking.</td>
<td>Both ink cartridges may still have the tape on, are missing, are defective, or are very low on ink.</td>
</tr>
<tr>
<td></td>
<td>● If the pink tape is still on the ink cartridges, remove it.</td>
</tr>
<tr>
<td></td>
<td>● If the ink cartridges are missing, install the missing ink cartridges.</td>
</tr>
<tr>
<td></td>
<td>● If the ink cartridges are defective, replace the ink cartridges. See Identify a defective cartridge on page 61 to identify if only one ink cartridge is a defective.</td>
</tr>
<tr>
<td></td>
<td>● If the ink cartridges are very low on ink, press any button, except the Cancel button, to resume printing, and replace both ink cartridges when print quality is no longer acceptable. For more information, see Replace ink cartridges on page 39.</td>
</tr>
<tr>
<td>The On button light, both Cartridge lights, and the Attention light are blinking.</td>
<td>The printer is in an error state. To exit the error state, reset the printer.</td>
</tr>
<tr>
<td></td>
<td>1. Turn off the printer.</td>
</tr>
<tr>
<td></td>
<td>2. Unplug the power cord.</td>
</tr>
<tr>
<td></td>
<td>3. Wait a minute, and then plug the power cord back in.</td>
</tr>
<tr>
<td></td>
<td>4. Turn on the printer.</td>
</tr>
<tr>
<td></td>
<td>If the problem persists, contact HP.</td>
</tr>
</tbody>
</table>
Auto-Off

Auto-Off is automatically enabled by default when you turn on the printer. When Auto-Off is enabled, the printer will automatically turn off after 2 hours of inactivity to help reduce energy use. **Auto-Off turns the printer off completely, so you must use the On button to turn the printer back on.** For printer models with wireless or Ethernet network capability, Auto-Off is automatically disabled when the printer establishes a wireless or Ethernet network connection. Even when Auto-Off is disabled, the printer enters Sleep mode after 5 minutes of inactivity to help reduce energy use.

To change the Auto-Off setting from the printer software

1. Depending on your operating system, do one of the following to open the printer software:
   - **Windows 8:** On the **Start** screen, right-click an empty area on the screen, click **All Apps** on the app bar, and then click the icon with the printer's name.
   - **Windows 7, Windows Vista,** and **Windows XP:** From the computer desktop, click **Start,** select **All Programs,** click **HP,** click **HP Deskjet 1510 series,** and then click **HP Deskjet 1510 series.**

2. In the printer software, select **Print & Scan,** and then click **Maintain Your Printer** to access the printer toolbox.

3. The printer toolbox appears.

4. Click **Advanced Settings,** and then follow the on-screen instructions.

Once you change the setting, the printer maintains the setting that you choose.
3 Print

This section contains the following topics:

- Print documents
- Print photos
- Print envelopes
- Print using the maximum dpi
- Tips for print success
Print documents

Load paper

1. Make sure the output tray is open.
2. Make sure you have paper loaded in the input tray.

To print a document

1. From your software, click the Print button.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.
4. Select the appropriate options.
   ● On the Layout tab, select Portrait or Landscape orientation.
   ● On the Paper/Quality tab, select the appropriate paper type and print quality from the Media drop-down list.
   ● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.
5. Click OK to close the Properties dialog box.
6. Click Print or OK to begin printing.

To print on both sides of the page

1. From your software, click the Print button.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.
4. Select the appropriate options.
● On the **Layout** tab, select **Portrait** or **Landscape** orientation.

● On the **Paper/Quality** tab, select the appropriate paper type and print quality from the **Media** drop-down list.

● Click **Advanced** to select the appropriate paper size from the **Paper Size** drop-down list.

5. On the **Layout** tab, select an appropriate option from the **Print on Both Sides Manually** drop-down list.

6. Click **OK** to print.

7. After the even numbered pages of the document have been printed, remove the document from the output tray.

8. Follow the on-screen instructions, reload the paper in the input tray with the blank side up and top of page down, and then click **Continue**.
Print photos

Load photo paper

1. Make sure the output tray is open.

2. Remove all paper from the input tray, and then load the photo paper with side to be printed on facing up.

To print a photo on photo paper

1. On the File menu in your software, click Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.

4. Select the appropriate options.
   - On the Layout tab, select Portrait or Landscape orientation.
   - On the Paper/Quality tab, select the appropriate paper type and print quality from the Media drop-down list.
   - Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

   NOTE: For maximum dpi resolution, go to the Paper/Quality tab and select Photo Paper, Best Quality from the Media drop-down list. Then go to the Advanced tab and select Yes from the Print in Max DPI drop-down list. If you want to print Max DPI in grayscale, select High Quality Grayscale from the Print in Grayscale drop-down list.

5. Click OK to return to the Properties dialog box.

6. Click OK, and then click Print or OK in the Print dialog box.

   NOTE: After the printing is finished, remove unused photo paper from the input tray. Store the photo paper so it does not start to curl, which could reduce the quality of your printout.
Print envelopes

You can load one or more envelopes into the input tray of the HP Deskjet 1510 series. Do not use shiny or embossed envelopes or envelopes that have clasps or windows.

**NOTE:** For details on how to format text on envelopes, see the help files in your word processing software.

Load envelopes

1. Make sure the output tray is open.
2. Slide the paper-width guide all the way to the left.
3. Place the envelopes in the right side of the input tray. The side to be printed on should face up.
4. Push the envelopes into the printer until they stop.
5. Slide the paper-width guide firmly against the edge of the envelopes.

To print an envelope

1. On the File menu in your software, click **Print**.
2. Make sure your printer is selected.
3. Click the button that opens the **Properties** dialog box.

   Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer Properties**, **Printer**, or **Preferences**.

4. Select the appropriate options.
   - On the **Layout** tab, select **Portrait** or **Landscape** orientation.
   - On the **Paper/Quality** tab, select the appropriate paper type and print quality from the **Media** drop-down list.
   - Click **Advanced** to select the appropriate paper size from the **Paper Size** drop-down list.
5. Click **OK**, and then click **Print** or **OK** in the **Print** dialog box.
Print using the maximum dpi

Use maximum dots per inch (dpi) to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of memory.

To print in Maximum dpi mode

1. On the File menu in your software, click Print.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.
4. Click the Paper/Quality tab.
5. From the Media drop-down list, must select Photo Paper, Best Quality to enable printing in maximum dpi.
6. Click the Advanced button.
7. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.
8. Select the appropriate paper size from the Paper Size drop-down list.
9. Click OK to close the advanced options.
10. Confirm Orientation on the Layout tab, and then click OK to print.
Tips for print success

To print successfully, the HP ink cartridges should be functioning properly with sufficient ink, the paper should be loaded correctly, and the product should have the appropriate settings. Print settings do not apply to copying or scanning.

Ink tips

● Use original HP ink cartridges.
● Install both the black and tri-color cartridges correctly.
   For more information, see Replace ink cartridges on page 39.
● Check the estimated ink levels in the ink cartridges to make sure there is sufficient ink.
   For more information, see Check estimated ink levels on page 36.
● If the print quality is not acceptable, see Improve print quality on page 50 for more information.

Paper loading tips

● Load a stack of paper (not just one page). All of the paper in the stack should be the same size and type to avoid a paper jam.
● Load paper with side to be printed on facing up.
● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide does not bend the paper in the input tray.
   For more information, see Load media on page 22.

Printer settings tips

● On the Paper/Quality tab, select the appropriate paper type and print quality from the Media drop-down list.
● Select the appropriate paper size from the Paper Size drop-down list in the Advanced Options dialog box. Access the Advanced Options dialog box by clicking the Advanced button on the Layout or Paper/Quality tab.
● To change default print settings, click Print & Scan, and then click Set Preferences in the printer software.

Depending on your operating system, do one of the following to open the printer software:

◦ Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name.
◦ Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All Programs, click HP, click HP Deskjet 1510 series, and then click HP Deskjet 1510 series.
● If you want to print a black and white document using black ink only, click the Advanced button. From the Print in Grayscale drop-down menu, select Black Ink Only, then click the OK button.
Notes

- Original HP ink cartridges are designed and tested with HP printers and papers to help you easily produce great results, time after time.

  **NOTE:** HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a result of using a non-HP supply will not be covered under warranty.

  If you believe you purchased original HP ink cartridges, go to:

  www.hp.com/go/anticounterfeit

- Ink level warnings and indicators provide estimates for planning purposes only.

  **NOTE:** When you receive a low-ink warning message, consider having a replacement ink cartridge available to avoid possible printing delays. You do not need to replace the ink cartridges until print quality becomes unacceptable.

- Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.

- You can print your document on both sides of the paper.
You can load many different types and sizes of paper in the HP Printer, including letter or A4 paper, photo paper, and envelopes.

This section contains the following topics:

- Recommended papers for printing
- Load media
Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

ColorLok

- HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

Photo printing

- HP Premium Plus Photo Paper
  HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them right off the printer. It is available in several sizes, including A4, 8.5 x 11 inch, 4 x 6 inch (10 x 15 cm), 5 x 7 inch (13 x 18 cm), and 11 x 17 inch (A3), and in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing, displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers exceptional results with professional quality and durability.

- HP Advanced Photo Paper
  This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch), 13 x 18 cm (5 x 7 inch). It is acid-free for longer lasting documents.

- HP Everyday Photo Paper
  Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch). For longer-lasting photos, it is acid-free.

Business documents

- HP Premium Presentation Paper or HP Professional Paper 120
  These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters. They are heavyweight for an impressive look and feel.

- HP Brochure Paper or HP Professional Paper 180
These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

**Everyday printing**

- **HP Bright White Inkjet Paper**
  
  HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

- **HP Printing Paper**
  
  HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial than documents printed on standard multipurpose or copy paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

- **HP Office Paper**
  
  HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

- **HP Office Recycled Paper**
  
  HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber. It features ColorLok Technology for less smearing, bolder blacks and vivid colors.

**Special projects**

- **HP Iron-On Transfers**
  
  HP Iron-on Transfers (for light or white fabrics) are the ideal solution for creating custom T-shirts from your digital photos.
Load media

Select a paper size to continue.

Load full-size paper

1. Raise the input tray.

2. Lower the output tray and pull out the output tray extender.

3. Slide the paper-width guide to the left.

4. Insert a stack of paper into the input tray with the short edge down and the print side up, and slide the stack of paper down until it stops.
5. Slide the paper-width guide to the right until it stops at the edge of paper.

Load small-size paper

1. Raise the input tray.

2. Lower the output tray and pull out the output tray extender.

3. Slide the paper-width guide to the left.
4. Insert a stack of photo paper with the short edge down and the print side up, and slide the stack of paper forward until it stops.

5. Slide the paper-width guide to the right until it stops at the edge of paper.

**Load envelopes**

1. Raise the input tray.

2. Lower the output tray and pull out the output tray extender.

3. Slide the paper-width guide to the left and remove all paper from the input tray.
4. Insert one or more envelopes into far-right side of the input tray and slide the stack of envelopes down until it stops.

   The side to be printed on should face up. The flap should be on the left side and facing down.

5. Slide the paper-width guide to the right against the stack of envelopes until it stops.
5 Copy and scan

- Copy documents
- Scan to a computer
- Tips for copy success
- Tips for scan success
Copy documents

**NOTE:** All documents are copied in normal quality print mode. You cannot change the print mode quality when copying.

1-sided original to 1-sided copy

1. Load paper in the input tray.

2. Load the original.
   a. Lift the lid of the printer.
   b. Load the original print side down on the right front corner of the scanner glass.
c. Close the lid.

3. Press either Start Copy Black or Start Copy Color to start the copy.
   You can increase the number of copies (up to 9) by pressing the button multiple times.
Scan to a computer

To scan to a computer, the HP Deskjet 1510 series and computer must be connected and turned on.

Single page scan

1. Load the original.
   a. Lift the lid of the printer.
   b. Load the original print side down on the right front corner of the scanner glass.
   c. Close the lid.

2. Start the scan.
   a. Start the scan job using the printer software. Depending on your operating system, do one of the following to open the printer software:
- **Windows 8:** On the **Start** screen, right-click an empty area on the screen, click **All Apps** on the app bar, and then click the icon with the printer's name.

- **Windows 7, Windows Vista,** and **Windows XP:** From the computer desktop, click **Start**, select **All Programs**, click **HP**, click **HP Deskjet 1510 series**, and then click **HP Deskjet 1510 series**.

b. In the printer software, select the **Print & Scan** tab, and then select **Scan a Document or Photo** under **Scan**. You will see scan options that you can select on the computer screen.
Tips for copy success

- Load your original print side down on the right front corner of the scanner glass.

- To resize the copy, scan the original to the computer, resize it using an application on the computer, and then print the resized document.

- Clean the scanner glass and make sure that there are no foreign materials adhering to it.

Click here to go online for more information.
Tips for scan success

- Load your original print side down on the right front corner of the scanner glass.

- Clean the scanner glass and make sure that there are no foreign materials adhering to it.

Click here to go online for more information.
This section contains the following topics:

- Check estimated ink levels
- Order ink supplies
- Choose right ink cartridges
- Replace ink cartridges
- Use single-cartridge mode
- Cartridge warranty information
- Tips for working with ink cartridges
Check estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace an ink cartridge. The ink supply level shows an estimate of the amount of ink remaining in the ink cartridges.

To check the ink levels

1. Depending on your operating system, do one of the following to open the printer software:
   - **Windows 8**: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer’s name.
   - **Windows 7, Windows Vista, and Windows XP**: From the computer desktop, click Start, select All Programs, click HP, click HP Deskjet 1510 series, and then click HP Deskjet 1510 series.

2. In the printer software, click Estimated Ink Levels.

**NOTE:** If you have installed a refilled or remanufactured ink cartridge, or an ink cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.

**NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement ink cartridge available to avoid possible printing delays. You do not have to replace the ink cartridges until the print quality is unacceptable.

**NOTE:** Ink from the ink cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the printer and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the ink cartridge after it is used. For more information, see [www.hp.com/go/inkusage](http://www.hp.com/go/inkusage).
Order ink supplies

Before ordering cartridges, locate the correct cartridge number.

Locate the cartridge number on the printer

• The cartridge number is located inside the cartridge access door.

Locate the cartridge number in the printer software

1. Depending on your operating system, do one of the following to open the printer software:
   • **Windows 8**: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name.
   • **Windows 7, Windows Vista**, and **Windows XP**: From the computer desktop, click Start, select All Programs, click HP, click HP Deskjet 1510 series, and then click HP Deskjet 1510 series.

2. In the printer software, click Shop, and then click Shop For Supplies Online.

   The correct cartridge number appears when you use this link.

To order original HP supplies for the HP Deskjet 1510 series, go to [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies). If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

**NOTE:** Ordering ink cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.
Choose right ink cartridges

HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested with HP printers to help you easily produce great results, time after time.
Replace ink cartridges

To replace the ink cartridges

1. Check that power is on.
2. Load paper.
3. Remove the ink cartridge.
   a. Open the cartridge access door and wait for the print carriage to move to the center of the printer.
   b. Press down to release the ink cartridge, and then remove it from the slot.
4. Insert new ink cartridge.
   a. Remove the ink cartridge from the packaging.
b. Remove the plastic tape using the pink pull tab.

c. Slide the ink cartridge into slot until it clicks into place.

d. Close the cartridge access door.

**NOTE:** The HP printer software prompts you to align the ink cartridges when you print a document after installing a new ink cartridge.
Use single-cartridge mode

Use the single-cartridge mode to operate the HP Deskjet 1510 series with only one ink cartridge. The single-cartridge mode is initiated when an ink cartridge is removed from the ink cartridge carriage. During the single-cartridge mode, the printer can copy documents and print jobs from the computer.

**NOTE:** When the HP Deskjet 1510 series operates in single-cartridge mode, a message is displayed on screen. If the message is displayed and two ink cartridges are installed in the printer, verify that the protective piece of plastic tape has been removed from each ink cartridge. When plastic tape covers the ink cartridge contacts, the printer cannot detect that the ink cartridge is installed.

Exit single-cartridge mode

- Install both the black and tri-color cartridges in the HP Deskjet 1510 series to exit single-cartridge mode.
**Cartridge warranty information**

The HP cartridge warranty is applicable when the cartridge is used in its designated HP printing device. This warranty does not cover HP ink cartridges that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the cartridge is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be found on the cartridge as indicated:

![Cartridge warranty date](image)

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the printer.
**Tips for working with ink cartridges**

Use the following tips to work with ink cartridges:

- To protect the ink cartridges from drying out, always turn the printer off using the On button, and wait until the On button light goes out.

- Do not open or untape ink cartridges until you are ready to install them. Leaving tape on the ink cartridges reduces ink evaporation.

- Insert the ink cartridges into the correct slots. Match the color and icon of each ink cartridge to the color and icon for each slot. Make sure the ink cartridges snap into place.

- After you insert new ink cartridges, align the printer for best print quality. See [Improve print quality on page 50](#) for more information.

- When the Estimated Ink Levels in the printer software shows one or both ink cartridges in a low state, consider getting replacement cartridges to avoid possible printing delays. You do not need to replace the ink cartridges until print quality becomes unacceptable. See [Replace ink cartridges on page 39](#) for more information.

- If you remove an ink cartridge from the printer for any reason, try to replace it again as soon as possible. Outside of the printer, if unprotected, ink cartridges begin to dry out.
This section contains the following topics:

- Connect a new printer
- USB connection
Connect a new printer

If you have not connected the printer to your computer, or you want to connect another new printer of the same model to your computer, you can use the **Connect a new printer** function to set up the connection.

**NOTE:** Use this method if you have already installed the printer software.

1. Depending on your operating system, do one of the following:
   - **Windows 8**: On the **Start** screen, right-click an empty area on the screen, and then click **All Apps** on the app bar.
   - **Windows 7, Windows Vista**, and **Windows XP**: From the computer desktop, click **Start**, select **All Programs**, click **HP**, and then click **HP Deskjet 1510 series**.

2. Select **Printer Setup & Software**.

3. Select **Connect a new printer**. Follow the on-screen instructions.
USB connection

The HP Deskjet 1510 series supports a rear USB 2.0 High Speed port for connection to a computer.

To connect the printer with the USB cable

1. Insert the printer software CD in the computer CD-ROM drive.

   **NOTE:** Do not connect the USB cable to the printer until you are prompted to do so.

2. Follow the on-screen instructions. When you are prompted, connect the printer to the computer by selecting **USB** on the **Connection Options** screen.

3. Follow the on-screen instructions.

   If the printer software has been installed, the printer will operate as a plug-and-play device. If the software has not been installed, insert the CD that came with the printer and follow the on-screen instructions.
8 Solve a problem

This section contains the following topics:

- Improve print quality
- Clear paper jam
- Unable to print
- Clear print carriage
- Identify a defective cartridge
- Prepare trays
- Resolve copy and scan issues
- Printer failure
- Ink cartridge problem
- Older generation cartridges
- HP support
Improve print quality

**NOTE:** To protect the ink cartridges from drying out, always turn the printer off using the On button, and wait until the On button light goes out.

To improve print quality

1. Make sure you are using original HP ink cartridges.

2. Check the printer software to make sure you have selected the appropriate paper type and print quality from the Media drop-down list.

   In the printer software, click **Print & Scan** and then click **Set Preferences** to access the print properties.

3. Check the estimated ink levels to determine if the ink cartridges are low on ink.

   For more information, see [Check estimated ink levels](#) on page 36. If the ink cartridges are low on ink consider replacing them.

4. Align the ink cartridges.

**To align the ink cartridges**

a. Load letter or A4 unused plain white paper into the input tray.

b. Depending on your operating system, do one of the following to open the printer software:

   - **Windows 8**: On the Start screen, right-click an empty area on the screen, click **All Apps** on the app bar, and then click the icon with the printer’s name.
   
   - **Windows 7, Windows Vista**, and **Windows XP**: From the computer desktop, click **Start**, select **All Programs**, click **HP**, click **HP Deskjet 1510 series**, and then click **HP Deskjet 1510 series**.

   c. In the printer software, click **Print & Scan** and then click **Maintain Your Printer** to access the printer toolbox.

      The printer toolbox appears.

   d. Click **Align Ink Cartridges** on the Device Services tab.

      The printer prints an alignment sheet.
e. Load the cartridge alignment sheet print side down on the right front corner of the scanner glass.

f. Press the Start Copy Black button. The printer aligns the ink cartridges. Recycle or discard the cartridge alignment sheet.

5. Print a diagnostics page if the ink cartridges are not low on ink.

To print a diagnostics page

a. Load letter or A4 unused plain white paper into the input tray.

b. Depending on your operating system, do one of the following to open the printer software:

   - **Windows 8**: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer’s name.

   - **Windows 7, Windows Vista**, and **Windows XP**: From the computer desktop, click Start, select All Programs, click HP, click HP Deskjet 1510 series, and then click HP Deskjet 1510 series.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the printer toolbox.

d. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page.
e. Review the blue, magenta, yellow, and black boxes on the diagnostics page.

6. Clean the ink cartridges automatically, if the diagnostic page shows streaks or missing portions of the color and black boxes.

To clean the ink cartridges automatically

a. Load letter or A4 unused plain white paper into the input tray.

b. Depending on your operating system, do one of the following to open the printer software:

   - Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer’s name.

   - Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All Programs, click HP, click HP Deskjet 1510 series, and then click HP Deskjet 1510 series.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the printer toolbox.

d. Click Clean Ink Cartridges on the Device Services tab. Follow the on-screen instructions.
If the above solutions do not resolve the problem, click here for more online troubleshooting.
Clear paper jam

Use the following steps to clear a paper jam.

Clear a paper jam from the input tray

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam will need to be cleared manually.

2. Pull the paper gently out of the input tray.

3. Press the Start Copy Black or Start Copy Color button on the control panel to continue the current job.

Clear a paper jam from the output tray

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam will need to be cleared manually.

2. Pull the paper gently out of the output tray.

3. Press the Start Copy Black or Start Copy Color button on the control panel to continue the current job.

Clear a paper jam from the cartridge access area

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam will need to be cleared manually.
2. Open the cartridge access door and slide the print carriage to the right to access the paper jam.

3. Press the Start Copy Black or Start Copy Color button on the control panel to continue the current job.

Clear a paper jam inside of the printer

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam will need to be cleared manually.

2. Open the cleanout door located on the bottom of the printer. Press tabs on both sides of the cleanout door.

3. Remove the jammed paper.
4. Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

5. Press the Start Copy Black or Start Copy Color button on the control panel to continue the current job.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Prevent paper jams

- Do not overfill the input tray.
- Remove printed papers from the output tray frequently.
- Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
- Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input tray must be the same size and type.
- Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide does not bend the paper in the input tray.
- Do not force paper too far forward in the input tray.
- Do not add paper while the printer is printing. If the printer is about to run out of paper, wait until the out of paper message appears before adding paper.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
Unable to print

If you are having trouble printing, you can download the HP Print and Scan Doctor, which can troubleshoot this issue for you automatically. To get the utility, click the appropriate link:

Take me to the HP Print and Scan Doctor download page.

NOTE: The HP Print and Scan Doctor may not be available in all languages.

Resolve print issues

Make sure that the printer is turned on and that there is paper in the input tray. If you are still unable to print, try the following in order:

1. Check for error messages from the printer software and resolve them by following the on-screen instructions.
2. Disconnect and reconnect the USB cable.
3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

a. Depending on your operating system, do one of the following:
   - Windows 8: Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers.
   - Windows 7: From the Windows Start menu, click Devices and Printers.
   - Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
   - Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Either double-click the icon for your printer, or right-click the icon for your printer and select See what’s printing to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer Offline.

d. If you make any changes, try to print again.

4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending on your operating system, do one of the following:
   - Windows 8: Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers.
   - Windows 7: From the Windows Start menu, click Devices and Printers.
Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Make sure the correct printer is set as the default printer.
   The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending on your operating system, do one of the following:

   Windows 8
   i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the Settings icon.
   ii. Click or tap Control Panel, and then click or tap System and Security.
   iii. Click or tap Administrative Tools, and then double-click or double-tap Services.
   iv. Right-click or touch and hold Print Spooler, and then click Properties.
   v. On the General tab, next to Startup type, make sure that Automatic is selected.
   vi. If the service is not already running, under Service status, click or tap Start, and then click or tap OK.

   Windows 7
   i. From the Windows Start menu, click Control Panel, System and Security, and then Administrative Tools.
   ii. Double-click Services.
   iii. Right-click the Print Spooler, and then click Properties.
   iv. On the General tab, next to Startup type, make sure that Automatic is selected.
   v. If the service is not already running, under Service status, click Start, and then click OK.

   Windows Vista
   i. From the Windows Start menu, click Control Panel, System and Maintenance, Administrative Tools.
   ii. Double-click Services.
   iii. Right-click the Print Spooler service, and then click Properties.
iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

**Windows XP**

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer.
The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as Default Printer.

d. Try using your printer again.

6. Restart the computer.

7. Clear the print queue.

**To clear the print queue**

a. Depending on your operating system, do one of the following:

   - **Windows 8**: Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers.

   - **Windows 7**: From the Windows Start menu, click Devices and Printers.

   - **Windows Vista**: From the Windows Start menu, click Control Panel, and then click Printers.

   - **Windows XP**: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your printer to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
Clear print carriage

Remove any objects, such as paper, that are blocking the print carriage.

See Clear paper jam on page 54 for more information.

**NOTE:** Do not use any tools or other devices to remove jammed paper. Always use caution when removing jammed paper from inside the printer.

[Click here to go online for more information.](#)
Identify a defective cartridge

If both the tri-color and black ink cartridge lights are blinking, and the On button light is on, both cartridges may still have tape on, be very low on ink, or are missing. First make sure that the pink tape has been removed from both cartridges, and that both ink cartridges are installed. If both ink cartridge lights are still blinking, then one or both cartridges may be defective. To determine if one cartridge is defective, do the following:

1. Remove the black ink cartridge.
2. Close the cartridge access door.
3. If the On button light blinks quickly, replace the tri-color cartridge. If the On button light does not blink, replace the black cartridge.
Prepare trays

Open output tray

▲ Output tray must be open to begin printing.

Close cartridge access door

▲ Cartridge door must be closed to begin printing.

Click here to go online for more information.
Resolve copy and scan issues

HP provides an HP Print and Scan Doctor (Windows only) that can help solve many common “Unable to scan” issues.

NOTE: The HP Print and Scan Doctor may not be available in all languages.

Take me to the HP Print and Scan Doctor download page.

Learn more about how to solve scan issues. Click here to go online for more information.

Learn how to solve copy issues. Click here to go online for more information.
Printer failure

Resolve printer failure.

▲ Turn the printer off, then on. If that does not resolve the problem, contact HP.

Please contact HP support for help.
Ink cartridge problem

First try removing and reinserting the ink cartridges. If this does not work, clean the cartridge contacts. If your problem is still not resolved, replace the ink cartridges. For more information, see Replace ink cartridges on page 39.

Clean the ink cartridge contacts

⚠️ **CAUTION:** The cleaning procedure should take only a few minutes. Make sure that the ink cartridges are reinstalled in the printer as soon as possible. It is not recommended to leave the ink cartridges outside of the printer longer than 30 minutes. This could result in damage to the printhead or the ink cartridges.

1. Check that power is on.

2. Open the cartridge access door and wait for the print carriage to move to the center of the printer.

3. Remove the ink cartridge indicated by the flashing cartridge light on the control panel.

4. Hold the ink cartridge by its sides with the bottom pointing up and locate the electrical contacts on the ink cartridge.

   The electrical contacts are the small gold-colored dots on the ink cartridge.

5. Wipe only the contacts with a dry swab or lint-free cloth.

⚠️ **CAUTION:** Be careful to wipe only the contacts, and do not smear any of the ink or other debris elsewhere on the ink cartridge.
6. On the inside of the printer, locate the contacts for the cartridge.

   The printer contacts are the set of gold-colored bumps positioned to meet the contacts on the ink cartridge.

7. Use a dry swab or lint-free cloth to wipe the contacts.

8. Reinstall the ink cartridge.

9. Close the cartridge access door, and check if the error message has gone away.

10. If you still receive the error message, turn the printer off, and then on again.

   **NOTE:** If one ink cartridge is causing problems, you can remove it and use the single-cartridge mode to operate the HP Deskjet 1510 series with only one ink cartridge.

   Click here to go online for more information.
Older generation cartridges

You will need to use a newer version of this cartridge. In most cases you can identify a newer version of the cartridge by looking at the exterior of the cartridge package and finding the Warranty Ends date.

If it says 'v1' several spaces to the right of the date, then the cartridge is the updated newer version. If it is an older generation cartridge, contact HP support for help or replacement.

Click here to go online for more information.
HP support

- Register printer
- Support process
- HP support by phone
- Additional warranty options

Register printer

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product support alerts. If you did not register your printer while installing the software, you can register now at http://www.register.hp.com.

Support process

If you have a problem, follow these steps:

1. Check the documentation that came with the printer.
2. Visit the HP online support website at www.hp.com/support.
   
   HP online support is available to all HP customers. It is the fastest source for up-to-date product information and expert assistance, and includes the following features:
   
   - Fast access to qualified online support specialists
   - Software and driver updates for the printer
   - Valuable troubleshooting information for common problems
   - Proactive printer updates, support alerts, and HP newsgrams that are available when you register the printer
3. Call HP support.
   
   Support options and availability vary by printer, country/region, and language.

HP support by phone

Phone support options and availability vary by printer, country/region, and language.

This section contains the following topics:

- Phone support period
- Placing a call
- Support phone numbers
- After the phone support period
Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support. Standard phone company charges apply.

Placing a call

Call HP support while you are in front of the computer and the printer. Be prepared to provide the following information:

- Product name (Located on the printer, such as HP Deskjet 1510, HP Deskjet Ink Advantage 1515)
- Product number (located inside the cartridge access door)
- Serial number (located on the back or bottom of the printer)
- Messages that appear when the situation occurs
- Answers to these questions:
  - Has this situation happened before?
  - Can you recreate it?
  - Did you add any new hardware or software to your computer at about the time that this situation began?
  - Did anything else occur prior to this situation (such as a thunderstorm, the printer was moved, etc.)?

Support phone numbers

For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be available at the HP online support website: www.hp.com/support. Contact your HP dealer or call the support phone number for your country/region to learn more about support options.

Additional warranty options

Extended service plans are available for the HP Deskjet 1510 series at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.
The technical specifications and international regulatory information for the HP Deskjet 1510 series are provided in this section.

For additional specifications, see the printed documentation that came with the HP Deskjet 1510 series.

This section contains the following topics:

- Hewlett-Packard Company notices
- Specifications
- Environmental product stewardship program
- Regulatory notices
Hewlett-Packard Company notices

The information contained herein is subject to change without notice.

All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior written permission of Hewlett-Packard, except as allowed under the copyright laws. The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

© 2012 Hewlett-Packard Development Company, L.P.

Specifications

Technical specifications for the HP Deskjet 1510 series are provided in this section. For more product specifications, see the Product Data Sheet at www.hp.com/support.

- System requirements
- Environmental specifications
- Input tray capacity
- Output tray capacity
- Paper size
- Paper weights
- Print specifications
- Copy specifications
- Scan specifications
- Print resolution
- Power specifications
- Cartridge yield
- Acoustic information

System requirements

Software and system requirements are located in the Readme file.

For information about future operating system releases and support, visit the HP online support website at www.hp.com/support.

Environmental specifications

- Recommended operating temperature range: 15 ºC to 32 ºC (59 ºF to 90 ºF)
- Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)
- Humidity: 15% to 80% RH non-condensing; 28 ºC maximum dewpoint
- Nonoperating (Storage) temperature range: –40 ºC to 60 ºC (–40 ºF to 140 ºF)
- In the presence of high electromagnetic fields, it is possible the output from the HP Deskjet 1510 series may be slightly distorted
- HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due to potential high electromagnetic fields

Input tray capacity

Plain paper sheets (80 g/m² [20lb]): Up to 50

Envelopes: Up to 5
Index cards: Up to 20
Photo paper sheets: Up to 20

**Output tray capacity**

Plain paper sheets (80 g/m² [20lb]): Up to 30
Envelopes: Up to 5
Index cards: Up to 10
Photo paper sheets: Up to 10

**Paper size**

For a complete list of supported media sizes, see the printer software.

**Paper weights**

Plain Paper: 64 to 90 g/m² (16 to 24 lb)
Envelopes: 75 to 90 g/m² (20 to 24 lb)
Cards: Up to 200 g/m² (110-lb index maximum)
Photo Paper: Up to 280 g/m² (75 lb)

**Print specifications**

- Print speeds vary according to the complexity of the document
- Method: drop-on-demand thermal inkjet
- Language: PCL3 GUI

**Copy specifications**

- Digital image processing
- Copy speeds vary according to the complexity of the document and model

**Scan specifications**

- Resolution: up to 1200 x 1200 ppi optical
  
  For more information about ppi resolution, see the scanner software.
- Color: 24-bit color, 8-bit grayscale (256 levels of gray)
- Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)
Print resolution

**Draft mode**
- Color Input/Black Render: 300x300dpi
- Output (Black/Color): Automatic

**Normal mode**
- Color Input/Black Render: 600x300dpi
- Output (Black/Color): Automatic

**Plain-Best mode**
- Color Input/Black Render: 600x600dpi
- Output (Black/Color): Automatic

**Photo-Best mode**
- Color Input/Black Render: 600x600dpi
- Output (Black/Color): Automatic

**Max DPI mode**
- Color Input/Black Render: 1200x1200dpi
- Output: Automatic (Black), 4800x1200 optimized dpi (Color)

Power specifications

0957-2385
- Input voltage: 100-240Vac (+/- 10%)
- Input frequency: 50/60 Hz (+/- 3Hz)

0957-2403
- Input voltage: 200-240Vac (+/- 10%)
- Input frequency: 50/60 Hz (+/- 3Hz)

**NOTE:** Use only with the power adapter supplied by HP.

Cartridge yield

Visit [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies) for more information on estimated cartridge yields.

Acoustic information

If you have Internet access, you can get acoustic information from the HP website. Go to: [www.hp.com/support](http://www.hp.com/support).
Environmental product stewardship program

Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment website at:

www.hp.com/hpinfo/globalcitizenship/environment/index.html

- Eco-Tips
- Paper use
- Plastics
- Material safety data sheets
- Recycling program
- HP inkjet supplies recycling program
- Power consumption
- Sleep mode
- Disposal of waste equipment by users
- Chemical substances
- Toxic and hazardous substance table (China)
- Restriction of hazardous substance (Ukraine)
- Restriction of hazardous substance (India)

Eco-Tips

HP is committed to helping customers reduce their environmental footprint. Please visit the HP Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

Paper use

This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.
Material safety data sheets

Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging products:

![ENERGY STAR](https://www.hp.com/hpinfo/globalcitizenship/environment/recycle/)

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Sleep mode

- Power usage is reduced while in Sleep mode.
- After initial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity.
- The time to Sleep mode cannot be changed.
Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, you should protect human health and the environment by handing over your waste equipment to a designated collection point for the recycling of waste electrical and electronic equipment. For more information, please contact your household waste disposal service, or go to http://www.hp.com/recycle.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/reach.

Toxic and hazardous substance table (China)

Restriction of hazardous substance (Ukraine)

Технічний регламент щодо обмеження використання небезпечних речовин (Україна)

Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою Кабінету Міністрів України від 3 грудня 2008 № 1057.
# Restriction of hazardous substance (India)

<table>
<thead>
<tr>
<th>Restriction of hazardous substances (India)</th>
</tr>
</thead>
<tbody>
<tr>
<td>This product complies with the &quot;India E-waste (Management and Handling) Rule 2011&quot; and prohibits use of lead, mercury, hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl ethers in concentrations exceeding 0.1 weight % and 0.01 weight % for cadmium, except for the exemptions set in Schedule 2 of the Rule.</td>
</tr>
</tbody>
</table>
Regulatory notices

The HP Deskjet 1510 series meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory model identification number
● FCC statement
● Notice to users in Korea
● VCCI (Class B) compliance statement for users in Japan
● Notice to users in Japan about the power cord
● European Union Regulatory Notice
● Declaration of conformity

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is SNPRB-1204-01. This regulatory number should not be confused with the marketing name (HP Deskjet 1510 All-in-One Printer, HP Deskjet Ink Advantage 1515 All-in-One Printer, etc.) or product numbers (B2L56 to B2L60, C5X22 to C5X27, etc.).
FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Notice to users in Korea

B 급 기기
(가정용 방송통신기기)

이 기기는 가정용(B급)으로 전자파적합등록을 한 기기로서 주 로 가정에서 사용하는 것을 목적으로 하며,
모든 지역에서 사용할 수 있습니다.

VCCI (Class B) compliance statement for users in Japan

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的として
いますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き
起こすことがあります。取扱説明書に従って正しい取り扱いをして下さい。

VCCI-B

Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。
European Union Regulatory Notice

Products bearing the CE marking comply with the following EU Directives:

- Low Voltage Directive 2006/95/EC
- EMC Directive 2004/108/EC
- Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter provided by HP.

If this product has telecommunications functionality, it also complies with the essential requirements of the following EU Directive:

- R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or product family and available (in English only) either within the product documentation or at the following website: www.hp.com/go/certificates (type the product number in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications products and for EU harmonized telecommunications products, such as Bluetooth® within power class below 10mW.

For EU non-harmonized telecommunications products (If applicable, a 4-digit notified body number is inserted between CE and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue telephone networks.
Products with wireless LAN devices

- Some countries may have specific obligations or special requirements about the operation of Wireless LAN networks such as indoor use only or restrictions of the channels available. Please make sure that the country settings of the wireless network are correct.

France

- For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For the latest requirements, see www.arcep.fr.

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY
Declaration of conformity

DECLARATION OF CONFORMITY
according to ISO/IEC 17050-1 and EN 17050-1

Doc #: SNPRB-1204-01-A

Supplier's Name: Hewlett-Packard Company
Supplier's Address: 138 Depot Road, #04-01, Singapore 109680

declare, that the product
Product Name and Model: HP Deskjet 3110 All-in-One Printer Series/ HP Deskjet 1512 All-in-One/ HP Deskjet Ink Advantage 1515 All-in-One Printer Series/ HP Deskjet Ink Advantage 1516 All-in-One
Regulatory Model Number: 1) SNMPB120401
Product Options: A1
Power Adapter: 0957-2385 (WW), 0957-2403 (For China and India only)

conforms to the following Product Specifications and Regulations:

EMC:
- CISPR 24:2010 / EN 55024:2010
- EN 61000-3-3:2008
- FCC CFR 47, Part 15 / ICES003, Issue 4

Safety:
- EN 62479:2010

Energy Use:
- Regulation (EC) No. 1275/2008
- ENERGY STAR® Qualified Imaging Equipment Operational Mode (OM) Test Procedure
- Regulation (EC) no. 278/2009

RoHS:
- EN 50581:2012


This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Additional Information:
1) This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The Regulatory Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be confused with the marketing name or the product numbers.
2) The product was tested in a typical configuration.

10 October 2012
HouMeng Yik, Manager

Local contact for regulatory topics only:
EU: Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, Germany

www.hp.eu/certificates
Index

A
after the support period 69

B
buttons, control panel 5

C
control panel
   buttons 5
   features 5
copy
   specifications 74
customer support
   warranty 69

E
environment
   Environmental product stewardship program 76
   environmental specifications 73

P
paper
   recommended types 20
phone support 68
phone support period
   period for support 69
print
   specifications 74

R
recycle
   ink cartridges 77
regulatory notices 80
   regulatory model identification number 80

S
scan
   scan specifications 74
support process 68
system requirements 73

T
technical information
   copy specifications 74
   environmental specifications 73
   print specifications 74
   scan specifications 74
   system requirements 73

W
warranty 69